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1. Chapter 1 - Getting Started 

1.1. Mapping Concept 

1.1.1. What is Mind Mapping? 
Mind map is simply a visualization tool which helps you think and learn more proficiently. A mind map is a graphic 
diagram used to represent your thoughts and ideas, tasks, or other items linked to a central key idea or theme. It 
is used to generate, visualize, structure and classify ideas. Mind maps are used as an aid in study, organization, 
problem solving, and decision making. Mind Mapping is the most effective, “brain-friendly” way for you to turn 
your unorganized, linear, fleeting ideas and thoughts into a structured, visual “map”. Mind Map represents the 
best of both worlds by resembling the visual aspects of a flow chart and the organizational structure of an outline. 

 

 
 
Mind map is an image-centered diagram that represents semantic or other connections between portions of 
information. By presenting these connections in a radial, non-linear graphical manner, it encourages a 
brainstorming approach to any given organizational task, eliminating the hurdle of initially establishing an 
intrinsically appropriate or relevant conceptual framework to work within.  
 
Most often the map involves images, words, and lines. The elements are arranged intuitively according to the 
importance of the concepts and they are organized into groupings, branches, or areas. The uniform graphic 
formulation of the semantic structure of information on the method of gathering knowledge may aid recall of 
existing memories. 
 

1.1.2. Why do I need Mind Mapping? 
 
The process of getting your thoughts organized.  
The ability to arrange information from many sources in a logical order has become the single most important 
factor for business survival in the modern world.  



 

 

The old linear pattern of thinking, by reading and describing from left to right - top to bottom - creates many 
problems when it comes to organizing the information we receive. One reason is that much of our information 
input comes through our senses - eyes, ears, etc. Then the information hits the brain.  
The human brain has left and right hemispheres, each with its own nature and functions. We have an incredible 
ability to process information which initially appears to have no pattern or order. This makes the thinking process 
very powerful - but it also makes it very complex.  
The brain can process visual information in a highly efficiently manner. This means that, if you can 'see' your 
thoughts in some way - such as a map - you can understand and re-order the relationships between different 
topics.  

1.1.3. What are the Basic Principles? 
 

The basic principles can be defined as:  
• Think as you work. This means getting ideas down on the page, without much concern for hierarchy and flow 

in the beginning.  
• Break big topics into their logic parts, and create these as sub-topics (branches).  
• If there are logical flows in a Map process, reflect them in the structure of the Map. This may mean 

sometimes going linear instead of radial with the Map design.  
• Add notes, icons and graphics to make the Map as informative as possible. If you add notes as you think of 

them, you're less likely to forget the information later.  
• If a Map is for a project plan, add schedule information to create clear time frames for appropriate topics. 
 
Remember to save and backup important Map files. Mapping is an iterative process - which means the ideas 
build and grow from other ideas. 'Brain-storming' can generate a brilliant set of ideas; these ideas may never 
happen in the same way again, so don't lose them! 

1.1.4. Mind Map Elements 
 

 



 

 

1.1.4.1. Title 
The map title is the main topic of the central idea that you want to create as a map. It is the central point, 
and everything else branches from it. 

1.1.4.2. Topic 
A Topic is the basic unit of a Mind Map. When you add atopic to a topic, you create a new branch that 
leads out a level to a new sub-topic. 

1.1.4.3. Branch 
A branch is a small but critical element in a map.Branch lines connect topics between two adjacent levels, 
showing their relationship.  There is no limit to the number of branches at each level. 

1.1.4.4. Level 
This is the hierarchy of branches, as they are mapped around a topic. You have probably seen the rings in 
the cross-section of a sawn log, or the ripple pattern created by an object thrown into a pond. They 
radiate out from the center. The same theory applies in the formation of a map, as thoughts spread out 
from the main topic. The number of levels might be limited by the memory capacity of a computer, but 
there is no limit in theory. In the sample map above, Level One consists of three branches (Topic 1, Topic 
2, and Topic 3). The seven sub branches define Level two. 

1.1.4.5. Other Elements 
Legends are small picture symbols that are used to put Map topics into categories. This makes it easy to 
read which topics in the Map go together.  
Graphics, in the form of Clip Art pictures, can be easily added. Their main purpose is to improve the look 
of the Map. Pictures can also help readers to understand the meaning of sections of the Map. 
Boundary and Shape can add emphasis to your topics. 
Tie Lines and Relation Lines can show additional relationships within a map. 

 

1.2. Mind Map Benefits 
 

1.2.1. Benefits 
Scholars have claimed that the mind map is a vastly superior note-taking method than the traditional methods. 
Mind mapping utilizes the full range of left and right human cortical skills to tap into the unused mental potential. 
Researchers have also shown that graphical organizers have superior recall than text outlines. 
 

Mind Map Benefits 

Learning Reduce those ‘tons of work'. Feel good about study, revision and 
exams. Have confidence in your learning abilities. 

Overview See the whole picture, the global view, at once. Understand the links 
and connections. 

Concentrating Focus on the task for better results. Using all of your cortical skills 
attracts your attention. 

Memorizing Easy recall. ‘See' the information in your mind's eye. 

Organizing Be on top of all of the details for parties, holidays, projects or any 
other subject. 

Presenting Speeches are clear, relaxed and alive. You can be at your best. 



 

 

Communicating In all forms with clarity and conciseness. 

Planning Orchestrate all details and aspects from beginning to end on one 
piece of paper. 

Collaborating Multiple users can simultaneously work on the same map for remote 
collaboration meeting 

Meetings From planning to agenda, to chairing, to taking the minutes … the 
jobs are completed with speed and efficiency.  

Training From preparation to presentation they make the job easier and 
much faster. 

Thinking Having a method to analyze thoughts - almost a ‘way-station' for 
them.  

Negotiating All the issues, your position and maneuverability in one sheet. 

Brainstorming Random thoughts are generated and appropriately assessed in real 
time 

 

1.2.2. Applications 
Mind maps have many applications in business, educational, and personal environments. 
 

1.2.2.1. Professional Business Environment 
• Project Management 
• Planning 
• Collaborating & Communicating 
• Brainstorming  
• Meetings  
• Training  
• Negotiating  
• Clarifying thoughts and ideas  

1.2.2.2. Academic Environment  
• Note taking  
• Report Organizing  
• Presentations  
• Exam study  

1.2.2.3. Small Business or Personal/Family environment 
• Tasks and to-do lists  
• Personal projects  
• Organizing  
• Problem analyzing and solving  
• Clarifying thoughts and ideas 

 

1.3. MindMapper 12 Screen Layout 
 



 

 

 
 

1.3.1. Quick Access Toolbar 
Quick Access Toolbar has your most basic commands for Opening and Saving a file.  You can customize the Quick 
Access Toolbar by right-clicking on the toolbar. 

1.3.2. File (MindMapper) Button 
MindMapper Button is similar to File menu in a traditional menu structure.  The entire file Open/Save operations 
can be found here.  Also the program options are located here as well. 

1.3.3. Ribbon Menu 

1.3.3.1. Home Tab 
Home tab contains the most basic and popular commands you need to construct a mind map. 

1.3.3.2. Ideation Tab 
The concept of Ideation is new to MindMapper 12.  This tab contains features which allow a user or a 
group of users to come up with different ideas based on a pre-defined set of meeting styles. 

1.3.3.3. Schedule Tab 
For Project Managers and other who wish to utilize the Scheduling feature, the commands are found here. 

1.3.3.4. Presentation Tab 
No need to export to PowerPoint to give your presentation.  You can present your mind map directly from 
within MindMapper. 

Quick Access Toolbar Ribbon MenuFile Button

Project Pane

Outline Pane

Schedule Window

Document Tabs Document Background View controls



 

 

1.3.3.5. Collaboration Tab 
Collaboration tab contain commands for online collaboration using MindMapper 

1.3.3.6. Tool Tab 
Tool tab contains features to add objects and extract and structure data  

1.3.3.7. View Tab 
With this tab, you can control the screen functions of MindMapper, such as Zooming and Panning. 

1.3.4. Schedule Window 
Schedule Window shows the defined Schedules and Resources.  This window can be toggled with F4 button. 

1.3.5. Project Pane 
Project pane contains different windows to help you work more efficiently.  Project Pane contains Cliparts, 
Legends, Ideation, Browser, and Note windows. 

1.3.6. View Controls 
View Controls contain quick controls to view your maps, such as zoom in and out, full screen more, etc.   

1.3.7. Document Background 
Background is your main working area of MindMapper. 

1.3.8. Document Tab 
Document tab shows all the currently opened maps.  You can quickly navigate between them by clicking on each 
document tab. 

1.3.9. Outline Pane 
Outline pane shows your current map in a traditional Outline form.  This window is toggled with the F8 key. 
 

1.4. Tutorial Map 
 

Tutorial Map is readily available by clicking the Question button, then choosing Tutorial Map. 
 

 
 

Tutorial Map contains the following important links: 
 
Tutorial Map - quickly learn how to create a basic mind map 
Sample Maps - see all different types of mind maps you can create with MindMapper 



 

 

PDF and Online Manual - get more in-depth user guide on MindMapper 
What's New - see all the new features in MindMapper 
Arena Collaboration Service – try out online map sharing and collaboration with others 

 

1.5. MindMapper Updates 
 

You can check for MindMapper updates in the same Help menu as the Tutorial Map 
 

 
 
New updates will have bug fixes and small feature additions, so be sure to periodically check this link. 
 

2. Chapter 2 - Creating a MindMap 
 

2.1. Starting a New Map 

2.1.1. Starting a new map with pre-defined Styles. 
 

 

To start a new map, press the MindMapper button, then 
New.  Or you can press Ctrl+Shift+n 

 
You'll see this New Map window appear. 



 

 

 
 
 
Map Style - This tab shows different types of Mind Maps you can create.  No matter which style you start with, you can 
always change it later. 
Map Template - This tab shows pre-installed templates you can use 
Map Samples - This tab shows the sample maps that you can use as a guide for your own map 
Recent Files - This tab lists your recently opened files. 
 
You may add more Map Styles and Templates.  You can even edit any of the Styles or Templates to fit your own 
mapping needs. 

2.1.2. Starting with a Blank New Map 
 

 

 
You can also choose to start a new map with the 
default style shipped with MindMapper.  This can be 
started with the keyboard, Ctrl+n, or by clicking on the 
New icon in the Quick Access Toolbar. 

 

2.2. Adding Topics 

2.2.1. Add First Level Topics 
After you have created a new Mind Map and entered the name of the main topic for the Map, your next step is to 
add the first level of branching topics. These may be the major tasks for a project, or the main parts of a process 
or plan. 
 
Be default, new topics are created as sub topic of the selected topic.  If the Title is selected, each added topic will 
become the first level topics.  If a first level topic is selected, then each added topic will be a second level topic. 
 



 

 

To add topics, simply select a Topic by clicking once with the mouse.  The selected topic will have a dotted outline 
around it to show that it is selected.  Then you can choose any of the following methods: 

• Press the Space Bar.  A new branch will appear.  Now you can start typing 
• Press the New Topic button in the Home Tab 

 

 
 

• The simplest way to add a topic is to just start typing after the parent topic is selected. 

2.2.2. Adding Multiple Topics Quickly 
With the keyboard, pressing Shift+<number> will automatically create multiple branches matching the inputted 
number.  The branches will be empty, so you will need to fill in each branch by double-clicking each branch to 
enter a text value.  See section 2.3 Editing Topics. 
 

Example:  Pressing Shift+7 when the Title is selected will 
produce the following map: 

 

 

Another way to quickly enter 
multiple topics is by clicking Multiple 
menu.  This command is also 
accessible by pressing Ctrl+Space 
 

 



 

 

You'll see Insert Multiple Topics 
window.  Just type in multiple items 
and press Enter after each item. 
 

 

When you press OK, you'll have a 
map with multiple topics 
 

 
 

2.2.3. Adding Multiple Topics with Topic Levels 
The above example shows adding multiple topics that are all on the same topic level.  You can use the Insert 
Multiple Topics dialog box to add topics of different level by indenting each line with a space or multiple spaces. 

In this example, Apples, Oranges, Carrots, 
Cucumbers, and Celeries are indented with 
one space. 
 
Fuji and Golden Delicious are indented 
with 2 spaces. 

 
And this shows the result: 

 



 

 

 

2.2.4. Adding Sibling Topics 
By default, MindMapper will add new topic as 
a child of the currently selected topic.  To add 
a sibling topic instead of a child topic, press 
New Topic button and then choose Sibling 
Topic menu. 
 
Keyboard Shortcut: Shift+Space 
 
To add a sibling topic above the selected topic, 
use the keyboard shortcut Ctrl+Shift+Space.  

2.2.5. Auto Pasting Topics 
Auto Pasting lets you quickly add topics to your map without tediously typing each topic. 
In Auto Paste mode, any text you highlight with your mouse in another application, such as Internet Explorer or 
Microsoft Word, automatically gets pasted into MindMapper as a topic text. 

 
 
Keyboard Shortcut: F6 
 
When you click this button, MindMapper goes into Auto Pasting Mode, and "Stop Auto Pasting (F6)" button 
appears in the top-left corner of your window. 
 



 

 

 
 
To cancel Auto Pasting, click that button or press the F6 key. 
 

2.2.5.1. Auto Paste Options 
 

Auto Paste options are found in the Miscellaneous tab of Options Dialog (MindMapper Button, 
MindMapper Options) 
 

 
 



 

 

Hide MindMapper when Auto Paste is on: When this checkbox is checked, MindMapper window 
automatically minimizes while Auto Paste is on.  When Auto Paste is turned off, MindMapper window 
re-appears. 

 
Auto Paste after Search Internet:  When this checkbox is checked, MindMapper automatically started Auto 

Paste mode whenever Search Internet function is invoked.  See Section 5.5.3 for Search Internet. 
 

2.2.6. Floating Topics 
Floating topics serve two purposes: 
1) Have text "floating" on the background, not connected to any topics 
2) Have another central title so you can have multiple maps on the page. 
 
To enter a floating topic, press New Topic, then Floating Topic. 
 

 
 
Mouse Shortcut: Just click anywhere on the Background where you want the text, and type away. 
Keyboard Shortcut: Ctrl-T 
 
Example below shows two floating texts in the map. 

 
 
This example shows a second mind map spawning from a floating text 



 

 

 

2.3. Editing Topics 

2.3.1. Change Topic Text 
To change the Title or any of the Topic text, simply select the topic and press F2.  Double clicking the topic will also 
enter editing mode. 
You can also open Edit Text dialog box by selecting a topic and pressing Shift+Enter.  This will open the Edit Text 
dialog box. 

2.3.2. Moving Topics around 
You can grab any topic and drag it to a new location. 
 

2.3.2.1. Moving to a new Child Topic 
This exercise will show moving the topic “Apple” as a child topic to “Cucumber” 
 
Click and drag Apple toward Cucumber 
As you want this to be a child of Cucumber, hover the mouse toward the end of Cucumber, and you’ll see an 
orange placement marker appear. 

 
 

Release the mouse button, and Apple now is move to a child of Cucumber. 
 



 

 

 
 

2.3.2.2. Moving to a new Sibling Topic 
This will show how to move topic and place it above or below (as a sibling) an existing topic. 
 
Click and drag Apple toward Cucumber. 
As you want this as a sibling of Cucumber, hover the mouse above Cucumber.  You’ll see an orange 
placement marker appear. 

 

 
 
Release the mouse button, and Apple is now a sibling of Cucumber. 
 

 
 
 
To move Apple below Cucumber, just hover the mouse below Cucumber, and you’ll see similar placement 
market under Cucumber. 
 
Pressing the Ctrl key during the entire process will Copy the topic instead of Moving it. 

 



 

 

2.3.3. Cut, Copy and Paste 
As with most applications running on Windows, MindMapper supports Cut, Copy and Paste.  You can find these 
commands in the menus, or use the keyboard shortcuts, Ctrl+x, Ctrl+c, and Ctrl+v.  You can even copy & paste 
from MindMapper to other apps, and also from other apps to MindMapper. 

2.3.4. Undo and Redo 
Undo and Redo buttons are found on the Quick Access Toolbar.  You can undo any mistake, so don't be shy 
experimenting with MindMapper.   MindMapper supports 99 levels of Undo. 

2.3.5. Word Wrapping 
 

MindMapper provides 3 different methods to break a long topic into multiple-line topics. 
 
• Press Ctrl-Enter where you want to line break to occur 
• Select the topic, and then use one of the sizing handles to drag the text box.  The text will wrap accordingly 

 
 

• Set your default line wrapping from the Options menu 

 
 



 

 

Word Wrapping and Sizing Operations 
• Shift Double click any text sizing handles to cancel word wrapping 
• Double click left or right sizing handles to remove extra horizontal spaces 
• Double click up or down sizing handles to remove extra vertical spaces 
• Double click any corner sizing handles to remove all extra spaces 
• You can select multiple topics for sizing operations 

2.3.6. Adding Topic Notes 
 

Concept of Mind Mapping is to just enter few key 
words to help you remember and recall the associated 
information.  However, not everyone has a 
photographic memory, and there will be a need to 
record more than just a few key words.  Using the 
Notes window, you can add full sentences, paragraphs, 
or even pictures to help you organize your thoughts. 
 
Notes windows is in the Project pane on the right side 
of the screen.  Click Note tab and a Note window will 
open. 
 
Or you can use the keyboard shortcut of F3 to toggle 
the Notes Window. 

 

 
 

 
 

 
When you toggle the Notes window by pressing Note or pressing F3, the Notes window will appear at the right 
side of the MindMapper Window. 
You can then enter text or even copy pictures into this Notes Window.  When you're finished, just click anywhere 
in the background.  You'll notice that your topic now has a small yellow Note icon, indicating that it has a note. 
 



 

 

This sample shows that topic Eggs 
has a Note associated with it.  The 
Note is "Eggs come in dozen 
cartons" 

 
 

2.3.7. Aligning Topics 
 
Align command is in the Draw group of the Home tab. 
Select multiple topics then choose one of the aligning commands to make your mind map topics neat and 
organized. 
 

  
 



 

 

2.3.8. Spacing Between Topics 

 

Spacing command is in Draw group 
of Home tab. 
You can also control spacing 
between sibling topics or between 
a parent and a child. 
 
Between Parents - will increase or 
decrease the branch length, thus 
changing the length between a 
parent and a child 
 
Between Siblings - will increase or 
decrease spacing between sibling 
topics 

2.4. Viewing and Navigating MindMapper 

2.4.1. Zooming 

 

2.4.1.1. Zoom Controls 
You can zoom in an out of your map many different ways. 
 
With your Mouse: Hold Ctrl, then use the Scroll Wheel to zoom in and out 
With your Keyboard: "=" to zoom in, "-" to zoom out 
With your Menu: View tab, Zoom button 

2.4.1.2. Zoom Area 
Click Zoom Area, and then select an area on the screen using your mouse.  Program will zoom into the 
rectangular area selected with your mouse. 

2.4.1.3. Fit to Window 
You can also zoom to see your entire map.  This command is called Fit to Window. 
Keyboard shortcut is Ctrl+F5.  In the menus, it's in the Zoom menu 

2.4.2. Panning 
You can also easily Pan, or move your MindMap around so you can see other parts of your map. 
 
With your Mouse: Right-click the background area and drag the mouse 
With your Menu:  Click the Pan button then use your left mouse button to drag.  Click Pan button 

again to turn off the feature. 
 



 

 

2.4.3. Roll Up / Roll Down 
 

As you add more topics to your map, it's inevitable that some maps will become quite complex with many topics 
and many levels of branches.   
You can use Roll Up / Down commands to make your map look simpler.  And you can use these commands to 
work on one area of the map at a time. 
Roll Up / Down commands are located in the Scope group of the View tab. 
 

 

2.4.3.1. Roll Up (one level) 
Roll Up command will hide the last showing branch level of the selected tree.  If the main title is selected, 
all last level branches will be hidden.  If only a sub-tree is chosen, then only the last level branches in this 
sub-tree will be hidden. 
You can press Roll Up repeatedly until there are no more topics to show. 
When you Roll Up, you still have topics attached, but they are just hidden. 
 
Mouse Shortcut: Hover your mouse between the parent and child topics where the branch lines 

converse.  Your mouse cursor will switch to a squiggly cursor.  Click left mouse 
button 

Keyboard Shortcut: Alt+Up Arrow 
 
Example: 

 



 

 

 
 
Select Title (Swot Analysis) and click Roll Up, and you’ll get the following. 
 

 
 
Now click Strength, and click Roll Up, and you’ll get the following: 
 

 



 

 

2.4.3.2. Roll Down (one level) 
Roll Down does the opposite of Roll Up.  If you have child topics hidden with Roll Up Command, then Roll 
Down command will again show the one child Topic level. 
Mouse Shortcut: Click on the circle with a small cross symbol next to the topic 
Keyboard Shortcut: Alt+Down Arrow 
 
Example: 
Continuing the example from above (2.4.3.1), if you choose Strength and click Roll Down, you’ll get the 
following: 
 

 

2.4.3.3. Full Roll Up 
Full Roll Up command rolls up all your topics and sub topics with one command. 
If you choose the Title text and choose Full Roll Up, all child branches will be hidden and you’ll only be left 
with the Title text 
 

 

2.4.3.4. Full Roll Down 
Full Roll Down command rolls down all your topics and sub topics with one command, so you’ll see the 
entire tree with all your child topics 

2.4.3.5. Conditional Roll Down 
Conditional Roll Down is similar to Roll down, in that it will cause one child level to roll down.  The 
difference is, whereas Roll Down will roll one child level down for all your branches, conditional roll down 
will remember your last roll up position, and then roll down one level only the topics that have not been 
rolled-up previously. 
 



 

 

2.4.4. Local Centering 
Local Centering is used to hide all other topics except for the one you want to view.  This is especially helpful if 
you want to concentrate working on one topic of your complex map. 
 

 
 
Click on one of the sub-topics, and then click Local Centering.  You'll notice that now you only see the sub topics 
you had selected. 
 
Press All Topics to go back to viewing all Topics again. 

2.4.5. Viewing Topics by Changed Date 
Highlight topics changed in the given scope.  i.e. Clicking -3 days will highlight all topics created or changed in the 
last 3 days. 
 

 
 

2.4.6. Full Screen Mode 
 

 

2.4.6.1. Full Screen 
If you wish to maximize your monitor's real estate space, pressing Full Screen will maximize the 
MindMapper window and also hide all menus and toolbars so you have the most optimal space to work 
on your maps. 
 



 

 

Press ESC to return to normal mode. 

2.4.6.2. Full Window 
Full Window is similar to Full Screen except your MindMapper window is not maximized.  Instead, the 
window size is kept the same, but the menus and toolbars will be hidden so you can maximize your 
current window. 
 
Press ESC to return to normal mode. 

2.5. Home Maps 
You can assign one or more maps you use frequently as Home Map.  Once assigned, you can open this map quickly 
just by pressing the Home icon 

2.5.1. Assign a Home Map 
  To assign a map a Home Map, open the map.  Then right-click the document tab for this map and press Set as 
Home Map. 

  

 
 
You can also set Home map by clicking the Home icon in the Quick Access Menu. 
 

 
 



 

 

 
 

2.5.2. Open a Home Map 
To open your Home Map, press the Home icon in the upper left portion of the MindMapper window. 
 

 
 

2.5.3. Multiple Home Maps 
  You can have up to 10 home maps assigned.  To add an additional home map, go to the Home Map options 
dialog in 2.5.1, and then click Add to add an additional home map. 

 

2.6. Saving your Maps 
 



 

 

 

2.6.1. MindMapper Map 
Choosing Save will save your map in default MindMapper TWDX format.  If you're saving your work for the first 
time, you'll be prompted to choose the folder where you wish to save the file. 

2.6.2. Pack 
Pack will gather all hyperlinks files on the current map, such as Word or Excel, then package them in one file for 
ease of sending.  Its function is similar to Zip files. 

2.6.3. Image 
Save your current map as an image file.  Your image choices are JPG, BMP, EMF, GIF, TIF, and PNG formats. 

2.6.3.1. Save as JPG using Logical Partitioning 
Instead of saving your large map into a single JPG image file, you can now logically divide your map and 
save them into multiple image files. 

 
 



 

 

Selecting "Yes" will save file into one image file (as with previous versions of MindMapper). 
Selecting "No" will split your map and save them into multiple images that are automatically numbered. 

2.6.4. Image (Selected Area) 
Select an area of your current map, then save the selected area as an image file. 

2.6.5. Web Page 
Save your current map as a Web Page (HTML document) so you can publish on the Web Server.  The links you 
have in your maps are preserved.  However only text portion of your map is Saved, the graphical design of your 
mind map is not saved.   
To save the graphical design, please see "Save as Image Map" 

2.6.6. Image Map 
Save your current map as a Web Page(HTML document) while preserving the graphical design of your mind map.   
This is especially helpful when you wish to emphasize the graphical relationship or flow of your mind map. 

2.6.7. MindMapper 12, 2009,  2008, 5.0, 4.5 – 3.0 Map 
If you have colleagues are using our legacy versions and you wish to share your maps with them, you need to save 
your file as one of the previous versions for compatibility. 

2.6.8. PDF 
Save your mind map as a PDF document.  PDF is the global standard document format.   You can save your mind 
maps as PDF file and most everyone will be able to view your mind map. 

2.6.9. XPS 
XPS, or XML Paper Specification, is another standard for saving documents in XML format.  If your colleague 
supports XPS, then you can save your maps in this format. 

2.6.10. Other Formats 
Text Save your map as text file, preserving only your topic text 
RTF Save your map as Rich Text Format file 
XML Save your map as Extensible Markup Language file 
 

2.6.11. Password Protect (Encrypt) your Map 
 You can apply a password to your map containing confidential information so others cannot open the file. 



 

 

To access the Password dialog, press Encrypt 
Document in Prepare section of the 
MindMapper menu. 
 

 

 

Enter the password and confirm it by entering it again. 
 
Please be sure to remember your password.  File with 
password cannot be opened if you forget the password. 

 
When opening the Password Protected file, 
you'll need to type in the password: 
 
To Remove the Password, open the file, the 
goto the Password Dialog box and and erase 
your password. 

 

 
 

 

2.7. Opening your Maps and other files 
You can open MindMapper files and also many other files with MindMapper. 
 
Open dialog box is in File Menu 



 

 

 
 
That will open the Open dialog box: 

 

2.7.1. Opening Mindjet MindManager files 
To open a MindManager file, click the file type dropdown control and choose MindManager files 
 



 

 

 
 

You must have Mindjet MindManager installed on your system to open MindManager files. 
 

2.7.2. Opening Freemind files 
Choose Freemind files in the file type dropdown control to open Freemind files. 
 



 

 

 

2.8. Printing your Maps 
 

 



 

 

 

2.8.1. Print Preview 
  Before you actually print, you can always see a Print Preview - what it would look like on paper.   
 

 
 
You can Preview your Map, Text, Schedule, Resources or Slides 
 
Page Setup and Print Preview is now incorporated into the same Window, so now you see your Page Setup 
changes in real-time with Print Preview. 

 

 
 



 

 

2.8.1.1. Print and Print Type 
 

 
 
Print: Print the Map 
Map: Show preview for Map printout 
Text: Show preview for Text printout 
Schedule: Show preview for Schedule printout 
Resource: Show preview for Resource printout 
Slide: Show preview for Slide printout 

 

2.8.1.2. Page Setup 
 

 
 
Paper Size:  Choose your Paper size 
Portrait/Landscape:  Choose Portrait or Landscape mode 
Print Range:  Choose which pages to view.  This is enabled only with multiple page printing via 

Physical or Logical printing 
Num of Copies:  Choose number of printout copies 
Physical Partition:  Choose Physical partitioning to print to multiple pages.  You must also choose 

Horizontal and Vertical values 
Logical Partition:  Choose Logical partitioning to print to multiple ages 
Print Scale:  Choose print size. 
Fit to Paper:  Print will enclose entire map on single paper 
Actual Font Size:  Print will use same font size as screen font size 

2.8.1.2.1. Physical Partition 
Physical partition lets you choose how many pages you want the map to be printed across.  
MindMapper will fit the printout to the number of pages set. 
For instance, if you choose Horizontal 2, and Vertical 2, your map will print out in 4 sheets of paper, 2 
across by 2 down.  You'll need to tape or glue the printout together to view the entire map. 

 



 

 

 
 

2.8.1.2.2. Logical Partition 
Logical Partition breaks your map into logical pieces.  Each logical piece is one topic (and all of its sub 
topics) in your map.  This one topic will be printed on one sheet of paper.  Each sheet of paper will 
have a separate topic printed on it. 

 

 
 

2.8.1.3. Options 
 



 

 

You can choose to include document property 
information using the Options dialog box.  

 
 

2.8.1.4. Descriptions 
 

You can place document description or properties on the printout by clicking on any of the small arrow 
located around the border of the document. 

 
 
When you click an arrow, a menu of items that can be printed will appear. 
You can place different document descriptions on different parts of the paper by clicking on other arrow. 



 

 

 
 

2.8.1.5. Preview 
 

 
 
One Page: Show one page 
Two Page: Show two pages 
All Pages: Show all pages 
Next Page: Show next page 
Prev Page: Show previous page 
Close:  Close Print Preview 

2.8.2. Print 
 

Print dialog box should look familiar to most users using the Windows operating system.  There are a few 
differences that will be outlined here. 
 



 

 

 
 

2.8.2.1. Print Type 
You can choose to select which information you wish to print.  Default is Map, but you can also print Text, 
Schedule, Resource and Slide. 

2.8.2.2. Preview 
Open Print Preview with Page Setup 

2.8.3. Print Selected Area 
 
Click Print Selected Area, and you’ll return to your current map.  Select an area on your map using your mouse, 
and you’ll automatically enter Print Preview mode with the selected area.  You can make any necessary 
adjustments, and then print the  
selected area. 
 
You can also select an area in your map while you’re working in the map. 
 



 

 

Right-click the mouse in the empty background 
area and choose Select Area 

 

Use your mouse to select an area by clicking one 
corner of the print area, then moving your mouse 
to the opposite corner. 
 
When the area is selected, you'll see a 
rectangular dotted area to indicate an area is 
selected. 
 
Now choose Print Area.  This will launch the Print 
Dialog and print the selected area 

 

 

3. Chapter 3 - Enhancing Your MindMap 

3.1. Basic Map Styles 

3.1.1. Sticky Notes 

3.1.1.1. Add Sticky Notes to your Background 
 

To add Sticky Notes to your map, click the Sticky Notes menu in Home tab. 
You’ll see a color pallet appear under the Ribbon Menus. 
 



 

 

 

Click one of the Sticky Notes colors 
and a blank note will appear on the 
screen.  You can double-click then 
type anything you want in the 
notes. 
 
You can change the note colors by 
clicking any of the colors in the 
Sticky Notes Pallett 
 
Keyboard shortcut: Shift + Left 
Mouse Click 

 

3.1.1.2. Grouping Notes Together 
Create notes, and then select multiple notes by dragging the mouse. 
To Group notes together, press Shift+Left Mouse Button, then enter a Title for the Group. 
Change the location of Group Title by selecting the title then press the Arrow keys to move the Group Title 
around. 
 



 

 

  
 

3.1.1.3. AttachSticky Notes to the Mind Map 
To attach a Note or a Group of Notes to a tree, simply drag the Note or Group of Notes (drag the Title of the 
Group) next to a map topic until you see a black arrow appear, then drop the group. 
 

 
 



 

 

3.1.2. Mapping Direction 

 
Mapping Direction determines shape and 
direction of the topics in the mind map tree. 
 
The Default mapping direction is Radial.  
However you can change the mapping 
direction for the entire tree, or to just a sub-
tree. 
 
To change the Mapping Direction for your 
entire tree, select the title, and then apply the 
Mapping Direction. 
 
To change the Mapping Direction for a sub-
tree, select the sub-topic, then apply the 
Mapping Direction. 
 
Mapping Direction command is in the Format 
group of the Home tab. 
 

 
 

3.1.2.1. Classic (Hand Drawn) for Artistic Look 
The Classic (Hand Drawn) style emulates the hand drawn style the original mind maps were meant to be.  
Adding colors to branches enhances the artistic look of the mind map. 

 
 



 

 

3.1.2.2. Fishbone 
 

 
Rightward Fishbone 
 

 
Leftward Fishbone 
 

3.1.2.3. Bi-Directional Hierarchy 

 
 
You can create this type of sample map 
 



 

 

 
 

3.1.3. Branch Style 

Branch Style determines the line types that link the topics 
together. 
 
Default branch style is Merged.  Other branch styles give a 
distinctive look for your map. 
 
For example, combining Mapping Direction of To Down with 
Branch style of Rectangle will give you a typical Organization 
Chart. 
 
Branch Style is found in Home tab / Format group. 

 

3.1.4. Font Style 

 

The Font group of the Home tab gives you the familiar 
formatting functions for your topic text. 



 

 

3.1.5. Line Property 

Selecting Line property will open a dialog box with 
multiple line style options. 
 
You can easily change the branch color by selecting 
one of the colors. 
 
You can also change the look and feel of the line by 
choosing the Thickness and Pattern. 
 
Line command is in Home tab, Draw group 

 

3.1.6. Fill 

 

Fill is used in a variety of ways. 
 
If you click the Background and choose Fill, you're 
setting the background color. 
 
If you select a topic or multiple topics, then you're 
setting the back color for the selected topic(s). 
 
If you selected a shape or shapes, then Fill will paint 
the shapes with the chosen color. 

 



 

 

3.1.7. Shape 

 

Shape is in the Draw group of the Home tab, 
 

Shape is used to draw a shape around a topic for 
added accent.  Once added, the shape can have 

different fill and line colors. 
 

 
 

You can also add shapes using the Component Pane, 
covered in section 3.2.1 

 



 

 

3.1.8. Boundary 
 

Whereas Shape is used to accent a single topic,  Boundary is used to accent a whole sub tree. 
Boundary feature is found in Design tab Shape group, on in Home tab Insert group. 
 

 
 
This sample shows Trumpet shape Boundary with Scallops Line around the Fruits sub tree. 
 

 
 

3.2. Applying Colors and Themes 

3.2.1. Component Pane 
 



 

 

 

Open the Component Pane by clicking Component tab in 
the Project Pan. 
 
Shape: 
Contains all shapes you can apply to the topic text.  Just 
select the topic, the click the desired Shape. 
 
Connector: 
Apply a Relation or Tie line to a set of topics. 
 
Boundary: 
Apply a boundary around a sub tree. 
 
 
 
Text: Color is applied to the topic text 
Line: Color is applied to the lines, such as branch line, 

shape line, etc. 
Fill: Color is applied to fill the shape 
 
Click on of the buttons: Text, Line, or Fill, then choose a 
color to apply the corresponding color. 
 
Theme Colors: 
These are you sample colors.  You can change the Theme 
colors by pressing Change Theme. 
You can also choose more colors by pressing More Colors. 
 
 
Line Properties: 
You can also change line properties - thickness, types, 
shapes, and arrows. 
 
 

 



 

 

3.2.2. Color Theme 
Color Themes allow you to quickly apply various colors to your map and background. 

 

 
 

 

3.2.3. My Pen 
MindMapper includes My Pen feature that emulates highlighted text in your mapping canvas. 
 
Use My Pen Settings to set your highlight color: 
 



 

 

 
 

Then turn My Pen On and create a 
new branch or a text. 

 

Newly create text will display in 
highlighted mode 

 
 

3.2.4. MindMapper Background 
You can set a specific fill color for the MindMapper background or set a picture as the background image. 



 

 

To launch the Background dialog box, right 
click any place in the Background, and then 
choose Background. 

 

This launches the Background dialog box. 
 
To Choose Background color: choose Color. 
To Choose Background Image: choose 
Image Select 
 

 
 

3.3. Legend Icons 
MindMapper includes more Legend icons and an improved user interface. 
Legend window is in the Project Pane is located in the right edge of the MindMapper window. 
 



 

 

 

 
Legends are used simply to identify or group topics together. 
Their use is purely subjective to each individual user. 
 
Below example show some use of Legends: 
 

 
 
Notice you can use more than one Legend icon per topic. 
 
 
To Remove Legend Icons, simply select the topic and press the same Legend 
Icon from the Legend window. 
 
To change the position of the Legends, click the right or left Location buttons 
at the bottom of the Legends Window. 

 

3.3.1. Change Legend Descriptions 

When you hover your mouse over a Legend Icon, a pop up 
text will give you a description of the Icon. 
 
You can easily change this pop-up description in the Legend 
Options. 
 
Legend Options can be accessed by right-clicking the Legend 
Icon area and selecting “Edit Legend”.  Or you can also access 
them via MindMapper Button – MindMapper Options. 
 

 
 



 

 

 
 
Just enter a new Description text then press Apply to make the change. 

3.4. Cliparts and Pictures 

3.4.1. Cliparts 
Cliparts are simple pictures that ship with MindMapper.  You can use Cliparts in your maps to add an additional 
design element and enhance the overall look of your map. 
 
You can toggle the Cliparts window by pressing Clipart button in the Design tab. 
 

 
Keyboard Shortcut: F2 key 
 
You can also open Clipart Window by clicking the Cliparts tab in the Project Pane 

3.4.1.1. Clipart Window 
Clipart Window has many different Categories.  The following shows Cliparts in Objects category 



 

 

 
 

3.4.1.2. InsertingClipart to Topic 
Open the Clipart window and then select a topic where you want to apply the clipart. 
Then simply choose and select the clipart you wish to insert.   The clipart will be automatically inserted to 
the selected Topic. 



 

 

 
Inserting Clipart to Main Title: By default, Clipart Position will be "Background" for the main topic. 
Inserting Clipart to other Topics: By default, Clipart Position will be "Right" when inserted into other Topics. 

3.4.1.3. Clipart Position 
 

Once the clipart is inserted to a Topic, 
you can change the Position of the 
Cliparts relative to the topic text. 

 

Up: 

 

Down: 

 

Left: 

 

Right: 

 

Background: 

 

3.4.1.4. Removing Cliparts 
To remove the Clipart, simply press the Remove Cliparts button. 

3.4.1.5. Inserting Clipart to Background 
Instead of inserting a Clipart to a topic, you can have Cliparts in the Background as free-floating object. 
 
To add a Clipart to the Background, just click and drag the clipart from the Clipart window to the 
Background area. 
Once placed in the Background, Cliparts can be moved around with the mouse, or re-sized by dragging one 
of the sizing handles. 
 
This sample shows a free-floating Clipart: 



 

 

 

3.4.2. Microsoft Clip Gallery 
If you have Microsoft Office installed, then you can also use the Clip Gallery supplied by Microsoft. 
To open the Microsoft Clip Gallery, click “Open Office Clipart” at the bottom of the Clipart window. 
 

 
 
This will open your MS Clip Gallery.   



 

 

 
* This window might differ depending on your version of Microsoft Office. 
 

To add Microsoft clipart to your Mind Map 
Background:  Copy the clipart you wish to use, and 
then Paste it into MindMapper background. 
 
To add Microsoft clipart to your Mind Map Topic: 
Copy the clipart you wish to use.  Then in 
MindMapper, select the topic where you want to add 
to.  Use the Paste command in MindMapper, and 
then choose Clipart. 

 
 

3.4.3. Images 
You may also insert any picture you have into MindMapper.  These can be pictures you took with your digital 
camera or other pictures you downloaded from the Internet.  To open your image, click Open command at the 
bottom of the Clipart window. 
 



 

 

 
 
To add Image to MindMapper Background: Click the MindMapper background then click Open command.  You'll 
see a familiar Open Dialog window where you can search for your picture. 
 
To add image to MindMapper Topic: Click a topic where you want to place the image, then click Open command.   
You'll see a familiar Open Dialog window where you can search for your picture. 

 

3.5. Relations and Ties 

3.5.1. Relations 
As your mind maps become more complex, you'll find instances where the simple parent-child relationship 
supplied by the default mind map is not sufficient.  Sometimes you'll see a relation between two child topics, each 
with a different parent topic. 
 
You can use Relation Lines to designate a special connection between any two topics. 

3.5.1.1. Add Relation Line 
 

To add a Relation Line, Choose Relation button in Illustration group, and choose one of 4 types. 
You can also use the Connector section of the Component Pane in the right side of the MindMapper 
window. 
 



 

 

 
 
Now choose the first topic.  As you move your mouse around a topic, you'll see pink/red snap points.  Click 
one. 
Now choose the second topic.  Again, you'll see the pink/red snap points.  Click one. 
You'll see a relation line appear between the two topics. 
You can also enter text for this special relation. 
 
Below example shows a relation between Apple and Celery 

 
 

3.5.1.2. Format Relation Lines 
Once the line is in place, you can easily style the line to fit your needs. 
Simply click on the line and a new Format menu will appear in the menu bar. 
 

 



 

 

 
You can change the shape of the Relation line by choosing one of the 4 types:  Rounded, Rectangle, Straight, 
or Bezier. 
 
Style menu group has commands to change the line type, line thickness, line pattern, and arrows. 
 
Also, you can stretch the Relation Lines by clicking and dragging the Text portion of the relation line. 
 
To delete a Relation line, simply click it and press the DEL button. 

3.5.2. Ties 
Whereas Relationship lines can only connect to 2 topics at a time, Tie can group many topics together.   

3.5.2.1. Add Ties 
To add a Tie Line, Choose Tie button in Illustration group, and choose one of 5 types. 
 

 
 
Now choose the first topic.  As you move your mouse around a topic, you'll see pink/red snap points.  
Choose one. 
Now choose the second topic.  Again, you'll see the pink/red snap points.  Choose one. 
You'll see a tie line appear between the two topics. 
You can also enter text for this special relation. 
 
Below example shows two tie lines: 



 

 

 
 

3.5.2.2. Format Tie Lines 
Once the line is in place, you can easily style the line to fit your needs. 
Simply click on the line and a new Format menu will appear in the menu bar. 
 

 
 

You can change the shape of the Tie line by choosing one of the5 types:  Rounded, Rectangle, Straight, 
Bezier or Brace. 
 
In the above example, First Tie is using Bezier shape with thick blue lines and double arrows. 
Second Tie is using Brace shape, with red dotted line and no arrows. 
 
Style menu group has commands to change the line type, line thickness, line pattern, an arrows. 
 
Also, you can stretch the Tie Lines by clicking and dragging the Text portion of the relation line. 
 
To delete a Tie line, simply click it and press the DEL button. 

 

3.5.3. Flow Charts 
You can create Flow charts by utilizing Floating Text and Straight Relation Lines. 
First, create your flow chart shapes by creating a Floating text, then adding Shapes. 
Please see Section 2.2.6 for adding Floating Text, and see Section 3.1.7 for adding Shapes. 
 



 

 

Once the basic shapes are in place, use Straight 
Relation Lines to connect the shapes.  Use 
Rectangular Relation Lines for angled lines. 
You can leave the text portion blank on most of 
your Relation lines. 
 
Here is a simple example on the right. 

 
 
 

3.5.4. Concept Maps 

Using the same basic principles as 
Flow Charts, you can easily create 
Concept Maps. 
 
Here is an example of a simple 
Concept Map 
 
All the nodes are floating topics. 
 
The lines between them are Straight 
Relation Lines 

 
 

3.6. Auto Numbering 
You can use Auto Numbering feature to quickly identify the order and the depth of each topic in your map. 
 
Auto Numbering button is in Style menu of Format group 



 

 

 
 
Choose one of the 5 styles for Auto Numbering.  To remove Auto Numbering, select Remove. 

3.7. Tables 

3.7.1. Built-in Table Feature 
 

 
 

 
Sample table in MindMapper 

3.7.1.1. Set As Table 
If one topic is selected, Set As Table will create a table for all the sub-topics entered henceforth.  If a topic 
and its subtopics are selected together, Set As Table will convert the existing sub-tree into a table, and all 
sub-topics entered henceforth will also be a table. 



 

 

Original Map Select Vegetable and click Set as Table Select title (Fruits a   
and click Set   

 
  

3.7.1.2. Set As Map 
Convert the table back to the traditional mind map format.  Selected topic must be the table title. 

3.7.1.3. Insert Column 
Insert a new column in the table 

3.7.1.4. Insert Row 
Insert a new row in the table 

3.7.1.5. Styles 
Choose one of the build-tin table styles 

 

3.7.1.6. Templates 
Choose one of the built-in table templates 



 

 

 
 

4. Chapter 4 - Using MindMaps 

4.1. DropBox and MindMapper mobile apps 
 

Mobile apps are available for Anrdoroid and iOS.  You can download and install the full version for free at Google Play 
and App Store. You can also utilize free DropBox service to share MindMapper files among your devices and with 
others.  You will need to sign up for this free service.  Go to www.dropbox.com and create an account. 
Once you have downloaded and installed DropBox on your PC and mobile devices, you can upload MindMapper file 
and access it from your PC or from your mobile devices.  
 
Once saved in the DropBox, you can download it to any of MindMapper installed devices, whenever and wherever 
you need the file.  
 
PC version is able to store TWDX file in any of the cloud storage services such as Google Drive and Sky Drive.  However, 
MindMapper mobile, as of now, only supports DropBox. In order to work seamlessly with mobile devices, DropBox is 
required for the PC version.    

 

4.2. Ideation Meetings 
MindMapper contains Ideation meeting templates.  These templates are designed to make your meetings more 
efficient and productive. 
 

http://www.dropbox.com/


 

 

 
 
When you click one of the ideation meetings, the Ideation pane will open in the Task Pane with the corresponding 
ideation technique.  The Ideation pane will give you instructions and also guide you through your ideation meeting.  
You can also click “Sample Map” to see the result of a typical ideation meeting.  Sample map in image form is 
provided for each of the 8 ideation techniques. 

4.2.1. Brainstorming 
Brainstorming is a group creativity technique by which a group tries to find a solution for a specific problem by 
gathering a list of ideas spontaneously contributed by its members. 
 
1. Choose the topic 
2. Use Sticky notes to enter each idea.  New ideas can use any of the different colored sticky notes. 
3. Categorize the ideas by choosing a sub-topic 
4. Group ideas together into the corresponding sub topics. 
 
When you click Brainstorm, the following template will open.  Brainstorming will also automatically open the 
Sticky Notes window, along with the meeting clock. 
 
Double-click each sticky note and type your idea.  Click a different color to change sticky note color.  Drag and 
Drop a color note by clicking a color, then dragging to the background. 
 

 
 
*Also see section 3.1.1 Sticky Notes. 
 



 

 

4.2.2. Radiant Association 
Radiant Association is a process by which you start with a central topic and then radiate outward with each 
related idea, to induce logical and creative thoughts by imagination, association, and combination. 
 
Procedure 
1. Choose the main topic - Click the central node in the map and enter your topic. 
2. Imagine - Enter all ideas as a sub-topic of your main topic using core, key words 
3. Association - Now look at each sub-topic and ideate thoughts related to that topic.  Enter those as a sub-sub 

topic 
4. Combination - Look over all your key words and then use Drag and Drop to move topics around, thereby 

grouping similar ideas together. 
 
Double-click the Subject and add your subject.  Double-click each of the sub topics or sub-sub topics and keep 
adding your ideas. 

 
 

4.2.3. Attribute Listing 
Attribute Listing is used for problem solving or ideations to systematically improve attributes of product, service, 
or process. 
 
Procedure 
1. Enter the main topic - Click the main node and enter your product, service, or process name 
2. Enter attributes - Enter all noun attributes in the noun sub-tree, all adjective attributes in the adjective sub-

tree, and verb attributes in the verb sub-tree 
3. Develop idea - Look at each attributes and compare contrast with others to associate and combine into a 

useful idea. 
 
Double-click Subject and add your own subject.  Then double-click each of the topics and add your own attributes 
to the specified subject. 



 

 

 
 

4.2.4. Process Planning 
Use Process Planning to clearly and visually organize your tasks in scheduled order to maximize success. 
 
Procedure 
1. Enter your final goal and completion date in the main topic 
2. Enter your phases and milestones to achieve the goal in chronological order 
3. For each phase, list tasks and deliverables to successfully complete that phase 
 
Double-click Subject, and add your project title.  Then double-click each Phase and enter your project phases 
and/or milestones.  Finally, add your tasks for each Phase. 
 

 
 

4.2.5. Cause & Effect (Fishbone) 
Fishbone diagram is used to determine a specific cause or causes that created a certain problem, by diagramming 
a cause and effect relationship, thereby allowing easy analysis and solution to the problem. 
 



 

 

Procedure 
1. Enter the problem in the main topic 
2. Enter all causes related to the problem 
3. Enter detailed reasons for each cause in the diagram. 
 
Double-click Subject and add your Subject. This should be the final Effect of the diagram. 
Double-click each Cause and add your specific Causes that is causing the Effect.  Fill in the Reasons for each Causes. 

 
 

4.2.6. Backward Thinking 
Backward Thinking is a process by which a successful project completion is assumed, then listing ideas and tasks 
to fulfill the successful completion of the project in reverse time order. 
 
1. Determine the main topic and completion date 
2. List all main dates and milestones necessary for a successful completion.  These will be your main stages. 
3. For each stage, list all required dates with items and deliverables, as well as potential pitfalls and caution 

items.  Utilize the built-in Gantt chart to help your scheduling. 
 
Double-click Project and enter your project title along with the completion date.  Double-click Success Image and 
enter some images that reflect successful project completion. 
For each countdown day (D-1, D-2, etc), enter a task that needs to be performed and complete in order to 
successfully complete this project. 
 



 

 

 
 

4.2.7. SWOT Analysis 
SWOT Analysis is a strategic planning method used to evaluate the internal Strengths and Weaknesses, and 
external Opportunities and Threats involved in a project or in a business. 
 
Procedure 
1. Enter your subject 
2. Enter few items for each of the Strengths, Weaknesses, Opportunities and Threats. 
3. Now the next set of sub-topics will be automatically created for you when you click Build Strategies. 

SO – strategies that use strengths to maximize opportunities 
ST – strategies that use strengths to minimize threats 
WO – strategies that minimize weaknesses by maximizing opportunities 
WT – strategies that minimize weakness and avoid threats 

4. Form your winning strategy based on these ideas. 
 

Double-click Subject and enter your subject.  Double-click each fact, and then enter the Strengths, Weaknesses, 
Opportunities, and Threats. 
Once you’re done with your map, click Build Strategies in the Ideation pane to build your SWOT strategy. 
 

 
 
SWOT Analysis Example: 
Let’s say you’re contemplating opening a gourmet burger restaurant, and want a SWOT analysis.  It might look 
similar to this: 



 

 

 
Now click “Build Strategies” to see your SO, ST, WO, and WT strategies. 
 

4.2.8. Forced Connection 
Forced Connection takes disjoint objects or ideas, and then forcefully connect them to come up with more 
creative ideas. 
 
Procedure 
1. Enter the main subject 
2. Choose a bridge word 
3. Enter all thoughts coming from the bridged word. 
4. Try to forcefully combine and associate ideas from the bridged word with your main subject 
 
You can choose your own bridge word, or use one the list provided by clicking View Bride Words in the Ideation 
pane.  
 

 
 

4.2.9. Ideation Options 
You can set Ideation Meeting Options by pressing Options in the Settings group 
 



 

 

 
 
This will open the following Options box 

 
 



 

 

4.2.10. Clock 
 
Brainstorming Sessions can use a Clock to time 
the meeting.  The Clock setting is entered by 
pressing Clock button. 

 
 

4.3. Spell Checking with Thesaurus 
Spell checker is improved with an updated Spell Checker engine for MindMapper.  Also, an integrated Thesaurus is 
now an included feature with MindMapper. 

4.3.1. Spell Checker 

4.3.1.1. Start Spell Checker 
    Select the topic you wish to check spelling, then press Spelling button in the Home tab Edit group. 

 
 
Keyboard Shortcut: F7 
 
If you select the main title (root topic), then the entire map will be checked for spelling.  If you wish to just 
spell check one sub tree, just select the topic of that sub tree. 

If the Spell Checker does not find any 
spelling errors, then it will return the 
following dialog box. 

 

4.3.1.2. Check Spelling Dialog Box 
    Below example shows a misspelled word "SPEL" that should be changed to "SPELL". 



 

 

 
Choose "SPELL" from the list of Suggestion, then click Change.  Your map is updated immediately with the 
correction. 
 
Ignore: This word is spelled correctly or intentionally misspelled.  So ignore this error. 
IgnoreAll: Ignore all other instances of this word 
Add: Add this word to your personal dictionary so it won't be flagged as an error . 
Dictionary: Opens your personal Dictionary where you can add your own words. 
Option: Dictionary Options 

4.3.1.3. Dictionary Options 

MindMapper ships with 3 different 
dictionaries.  They can be selected from the 
Main Dictionary Language dropdown. 
 
You choices are: 
- American English 
- British English 
- German 

 

4.3.1.4. Personal Dictionary 
   Clicking Dictionary from the Check Spelling opens the Dictionaries dialog box. 



 

 

You can add your own words, or 
delete words from the list. 
 
You can also choose a new file for your 
list of words from this dialog box. 

 
 

4.3.2. Thesaurus 
MindMapper also includes an integrated Thesaurusfeature.  To use the integrated thesaurus, simply select a topic, 
and then click the Thesaurus button menu. The Thesaurus window will open. 

 

 
 



 

 

 
 

Select the correct definition from the Categories list, and then double-click the term you would like to use to 
replace your word with any of the candidate terms. 

4.4. Hyperlinking 
Hyperlink is a wonderful feature.  It makes your document come to life with links to exciting web pages, multimedia 
content, pictures, spreadsheet and documents.  With hyperlinking, your map is not confined to the present data set. 
 
You can hyperlink web pages, other files (Word, Excel, pictures, music to name a few), a folder in your hard disk, and 
emails. 

Sample right shows a map with 
many hyperlinks: 

 



 

 

4.4.1. Inserting Web Page Hyperlinks 

4.4.1.1. Brower Pane 
MindMapper incorporates a built-in browser window so you can browse website quickly from within 
MindMapper.  Click the Browser tab in the Project pane to open the Browser window. 
 
   By default, the hyperlinked web pages that you click within MindMapper will also open in the Browser 
window. 

 
 
 If you do not wish to use the Browser window, and instead you’re your own browser to view web pages, 
you can change this setting in the Options dialog box. 
 
 Click File / MindMapper Options / Miscellaneous, then uncheck “Open hyperlinks webpage using built in 
browser” 
 



 

 

 

4.4.1.2. Insert Web Hyperlink Using Drag and Drop 
   Easiest way to insert a hyperlink into MindMap is by drag and drop.  To perform this, you need to open 
both your MindMapper and your browser, such as Internet Explorer. 
 
1) Open MindMapper, and also open Internet Explorer next to your MindMapper Window 
2) Navigate to the website where you want to attach the link in MindMapper.  Below example shows 

CNNwebsite.  We will insert the CNN.com hyperlink to the link that says “This is linked to Web Page”.  
Notice the link currently does not show any hyperlinks. 

 

 



 

 

 
 
3) In your browser, click and drag the icon next to the URL (www.cnn.com) to the topic where you wish to 

add the hyperlink.  When you release the mouse button, the MindMapper topic will show a hyperlink 
icon.   Clicking on the icon will now open the webpage. 

 
 
4) Verify the link by clicking it.  You'll see Internet Explorer start with the Google Websites. 
5) You can also verify by looking at the Hyperlink Properties.  Click Hyperlink button in Home tab, Topic 

group to show the Hyperlink Dialog box.  For hyperlinks, you need to choose Internet Address 
 

 
 
That will open the Hyperlink dialog box: 
 

http://www.cnn.com/


 

 

 
 
The dialog box correctly displays link to www.cnn.com. 
 

4.4.1.3. Insert Web Hyperlink using Hyperlinks Dialog Box. 
    You can also insert hyperlinks to a topic directly using the Hyperlink dialog box. 
 
1) First select a topic in your Mind Map, and then press Hyperlink in the Insert tab. 

 
 

Default internet browser will open so that you can go the website and copy the address: 
 

http://www.cnn.com/


 

 

 
 
2) Enter your URL in the Webpage text area.  You can also copy and paste a web address in that box.  Click 

the return arrow to the right when you are done. 
 

3) You’ll see your entered URL in the list. 
 

4.4.2. Inserting File Hyperlinks 

4.4.2.1. Insert File Hyperlink Using Drag and Drop 
 
To link a file to a topic in MindMapper, simply drag the file from Windows Explorer to a topic in 
MindMapper, and then drop it.  The MindMapper topic will show an icon indicating that a link   is present.  
You can verify the link by clicking the icon. 
 
Microsoft Office applications are automatically recognized and a special icon representing each application 
(Word, Excel, and PowerPoint) are placed as Hyperlink icons.  All other files, such  as Picture, Music, PDF, etc 
are shown with a generic Hyperlink icon, the blue ball. 
 



 

 

 

4.4.2.2. Insert File Hyperlink Using Hyperlinks Dialog Box 
To link a file to a topic in MindMapper using the Hyperlinks dialog box, first select the topic, then click 

Hyperlinks button in the menu. 
 

 
 

The Hyperlink dialog will start, and be empty initially.  Also the Link to File dialog will appear so you can 
select the linked file. 

 

 



 

 

  
 
Navigate using Link to File, select a file, then press Open.  The file is now hyperlinked to the selected 
topic. 

 

4.4.3. Inserting Folder Hyperlinks 

4.4.3.1. Insert Folder Hyperlink Using Drag and Drop 
The concept of linking folder is identical to linking a file.  Only difference is you can drag a folder instead of 
a file to a topic in MindMapper.  When you click the hyperlink in MindMapper, the folder  will open. 

4.4.3.2. Insert Folder Hyperlink Using Hyperlinks Dialog Box 
    You can follow the same guideline as Inserting a File Hyperlink Using Hyperlink Folder to insert a folder 
link.  Replace clicking Local File with Folder in the dialog box. 

4.4.4. Inserting Email Hyperlinks 
You can add an email to a topic such that a mouse click can open your client with the assigned email address. 
 
Select the topic where you wish to attach an email address, and then press the Hyperlink button. 
 
In the Address line, enter an email.  i.e. bob@xyz.com, then click OK. 
 
Note: You can also insert an email hyperlink by pressing the E-Mail button.  This button is activated only if you are 
using the Windows Address Book. 
 



 

 

 
Your topic will show a blue icon to show that you have a hyperlink. 
 
To verify the link, click on the blue icon.  Your email client will start with bob@xyz.com in the TO: field. 

 

4.4.5. Hyperlink Options 

4.4.5.1. Description 
You can enter a descriptive title in Description text box.  This description will show as Pop-Up text when you 
hover your mouse over the hyperlink, or when you click the hyperlink in case  where you have multiple 
hyperlinks. 

4.4.5.2. Path 
When you link files or folders, you have an option to set whether the file path is relative to the folder 
containing your local map, or absolute.  You can change the Relative or  Absolute path by clicking the Path 
line. 
 



 

 

 

4.4.5.3. Close current map action on hyperlink 
    You have an option on how the current map will behave when you click a hyperlink. 
    When you Check this option, the current map will close when you click the hyperlink, showing only the 
new linked file on the screen. 
    If you uncheck this, the current map will stay on the screen along with the newly opened file. 

4.4.6. Managing Multiple Hyperlinks 
You may have multiple hyperlinks attached to a single topic.  The topic will only show one hyperlink icon, but will 
preserve all the hyperlinks you have assigned to it. 
 
When you click on a topic with multiple hyperlinks, you'll see the list of hyperlinks and you can choose one.   
Example below shows the All Links topic having 4 hyperlinks: PDF file, Word doc, and 2 web addresses. 
 

 
 
To see all the hyperlinks and to manage them, simply right-click the topicand choose Hyperlinks to open the 
Hyperlink Window 
 



 

 

  
 
You can move a specific link up or down using the Up / Down buttons.  You can delete a link using Remove ubtton. 
 

4.4.7. Repair Broken Hyperlinks 
You can check the integrity of your hyperlinks by pressing Repair Broken Hyperlinks: 
 

 
 
MindMapper will go through each hyperlink in your map and verify the link is valid. 



 

 

If an error occurs, you'll see a dialog box where you can either remove the link or fix the path to restore the link. 
 

 

4.4.8. Remove Hyperlinks 
Select the Topic containing the hyperlink that you wish to remove.  Then open the Hyperlink Dialog box by clicking 
Hyperlink button in Insert tab. 
Click Remove button to remove the Hyperlink. 

4.5. Working with Fields 
Fields allow you to show some sample text, and when the user clicks the text, the text disappears and you can enter 
real data.  You can easily make a template map using fields. 
 
Here is a sample use of fields: 
 

 
 
Click on each blue-shaded box and type the real information 

 



 

 

 
Field menu is in the Tool tab 

 

4.5.1. Set Topic 
Select a topic or multiple topics, and then click Set Topic to convert them into a field.  The text will become light 
gray color. 
Now when you double-click this topic, the sample text will disappear, allowing you to enter real data. 

4.5.2. Cancel Topic 
Convert the field topics back into normal text topics. 

4.5.3. Purge Topic 
Remove all field topics and return all topics back to normal text topics. 

 

4.6. Splitting and Consolidating Mind Maps 
As your map becomes richer and more complex, working from a single file might not be the best idea.  It might be 
more efficient to break up your large map into smaller maps and link them with hyperlinks. 
 

4.6.1. Split 
To Split a large map into 2 or more maps, click the topic that you wish to break off, then click Split button in the 
Insert tab Structure group. 
 

 
 



 

 

 

This example shows a topic called "Technical 
Support" that has outgrown its sibling topics. 
 
To split this portion of the map, click “Technical 
Support” and click Split in the menu.. 
 
You'll see a Save window.  Save the new file 
containing just the Technical Support sub tree. 
 

 
Original File: 

 
Technical Support subtree is gone, but replaced with 
a hyperlink.  When you click the hyperlink, the new 
files opens. 

 
Detached File: 

 
 
The new file now contains only the Technical 
Support sub tree.  If you click the hyperlink in 
the Main Title, then you go back to the original 
document. 

 

4.6.2. Consolidate 
Consolidate is the direct opposite of Split.  Consolidate will take split files or hyperlinks files and combine them 
into a single file. 



 

 

 

 
 

4.7. Pack and Delivery 
When you have many hyperlinked files in your map and you wish to send your map to someone else for review, then 
just sending the map itself will not be enough.  Your recipient would be missing all the linked files, such as Excel 
spreadsheets and Word documents that might be linked to your mind map. 
To make sure all your linked files are included, use the Pack feature in MindMapper. 
Pack menu is found in Save as. 
 



 

 

    

 
 



 

 

Pack will combine your map with all the hyperlinked files and create an archived file with a file extension of TWDXS.  
This is similar to archived files such as *.zip or *.rar file.  The archive can be sent to anyone and they will have all the 
linked files for their viewing. 
 
You can also send packed file as an email attachment. Send> As Pack Attachment…will send the above feature one 
step further by automatically starting your Email client and attaching the Pack file as email attachment. 

4.8. Using and inserting Objects 

4.8.1. Equation Editor 
 

Equation Editor is in Tool tab, Object group. 
 

 
 
Click a topic where the Equation will go, then clicking Equation button will invoke Microsoft Equation Editor.  
Enter your equation: 
 

 
 
 
You can update MindMapper with your equation by clicking File / Update 
When you’re ready to return to MindMapper, choose File / Exit and Return to MindMapper 



 

 

 

 
 

4.8.2. Insert Special Characters 
 

 
 
In the Insert tab, Others group, you can insert symbol and special characters using Special Characters menu.  
Clicking it will open Microsoft Character Map program: 
 

 
 



 

 

Select your Font, and the desired character, then press Select to add the character to the edit box.  You can add 
multiple characters. 
Once you done, click Copy, then go back to your MindMapper program.  Select a topic and press Paste (or Ctrl+v) 
to paste the special characters. 

4.8.3. Screen Capture 
Clicking Screen Capture will hide your MindMapper program and show your screen.  Select an area of the screen 
using your mouse, and the selected area will automatically paste into your MindMapper program as an image. 
 

4.8.4. Using OLE Objects 
        Besides hyperlinking, you can also link objects using Microsoft OLE (Object Linking and Embedding) feature. 
 
Object menu is in the Tool tab. 
Common Object items, such as Excel sheet, Excel chart, and Equation are on the main. 
For other objects, choose Etc. menu. 
 

 
 
Insert Object dialog box will appear 

 

 
To create a new OLE object, select the object type 
from the list box and press OK. 

 



 

 

 

 
To link or embed and existing file, press 
"Create from File" button. 
The click Browse to open the File dialog 
and look for your file. 
 
Link: Check this to make a link to your file.  
If unchecked, the file will be embedded. 
 
Display as Icon: Check this to display the 
application icon. 

Your topic will now show the OLE 
Object. 

 

 

4.9. Setting up MindMapper 

4.9.1. Hiding / Showing Menus 
The Ribbon style menus appear by default. 

 

 
If you double click any of the menu names (i.e. double-click Home), then the menu will disappear, giving you a 
larger working area 



 

 

                         

 
 
To show the menus again, double-click on the menu name again. 

4.9.2. Customizing the Quick Access Toolbar 
You can customize the Quick Access Toolbar to remove the icons you do not want, and also to add additional 
icons. 
To access the menu, right click on the Quick Access Toolbar, or click the down arrow on the right side, then 
choose More Commands. 
 

 
 
The Quick Access options will open. 



 

 

 
 
You can choose any command you like and add them to the Quick Access Toolbar. 

4.9.3. Current Map Style 
Current map style settings are accessible through Map Style button in Format group of the Home tab. 
 

 
 



 

 

This opens the Style Dialog Box. 
 
All the changes made in the dialog box are for 
the current map only. 
 
You can press Reset All to restore all options to 
their default settings. 

 

4.9.4. Default Style 
If you wish to change the styles for all your future maps, then you need to either set the Default Style or Change 
the Default Template (next section) 
 



 

 

Open the Default 
Style options in by 
clicking the 
MindMapper 
Button, then 
pressing 
MindMapper 
Options. 
 
After you make the 
desired changes, 
press the OK 
button. 

 
 

Now, to start your 
new map with this 
newly defined 
style, you need to 
press the New icon 
in the Quick Access 
Toolbar or press 
Ctrl+n 

 

 
 

4.9.5. Changing Default Template 
 

Selecting the New button in MindMapper menu brings up the New Map 
dialog box. 

 
 



 

 

 
 

 

Map Style tab shows the default 
styles used for generating maps.  
Select the style you wish to modify, 
and then press the Modify button. 
 
MindMapper will open with the 
current style, and you can make 
changes, such as font color and size, 
color or shape of the topic text, etc. 
and save the style back.  You'll see 
the changes in the New Map 
window. 
 
Next time you start new map with 
the updated template, your map 
will show the applied style changes. 

 

4.9.6. Map Properties 
 
Open the Map Properties dialog box by pressing Prepare the MindMapper menu. 

 



 

 

 
This opens the Properties dialog box. 

 
 
Some items entered in Properties are used when you print with Index Printing Option to describe your map. 
 

5. Chapter 5 - Advanced Topics 

5.1. Managing a Project 

5.1.1. Schedules 

5.1.1.1. Schedule Window 
 

 
 

Schedule Windows appears when you add a schedule to a topic, or it can be manually toggled using the F4 
key. 
 
Topic List: displays the list of topics in your map that has an assigned schedule 
Summary Pane: displays the schedule and the cost for the task 
Resource Pane: lists the resources assigned to each task 



 

 

Schedule Pane: shows the schedule in Gantt chart form.  The color of the bars will match the color of the 
topic branch in your Mind Map.  As you change the topic branch color, your schedule color will change 
correspondingly. 
Scale Up & Down: Scales the schedule pane so you can view hours, days, weeks, or month intervals. 

5.1.1.2. Schedule Options 
Schedule Options are found in MindMapper Button / MindMapper Options. 

 

5.1.1.3. Adding Schedule to a Topic 
You can add a Schedule to a topic by selecting the topic and then by performing one of the following 
options: 
• Right Mouse Click then choose Schedule 
• Click Assign in Schedule group of the Schedule tab menu. 
• Press Ctrl+d with the keyboard 



 

 

  
 
When you Add a schedule, two things will happen 
• You'll notice a small, blue clock appear next to your topic text, indicating this topic has an associated 

schedule 
•  You'll notice the Schedule Window appear under the menus.  The Schedule window will show the 

selected task and automatically assign today's date as the schedule for this task.  The schedule 
window can be toggled on and off using the F4 key. 

5.1.1.4. Changing Schedule Dates 
By default, the Scheduler will assign today's date as the schedule for the assigned task.To change the date, 
you can use the Schedule Window or the Details Window 

5.1.1.4.1. Change Schedule Using the Schedule window 
 

 
 

To Change the Start Date: click on the left edge of the schedule bar and drag it to the desired date. 
To Change the End Date: click on the right edge of the schedule bar and drag it to the desired date. 
To Move the Schedule: click in the middle of the schedule bar and drag it to the desired date. 
 

5.1.1.4.2. Change Schedule Using the Details Window 
 



 

 

 

Schedule Details Windows can be opened using 
one of the following methods: 
 
1) In your Mind Map, double-click the clock icon 
next to the topic text 
 
2) In the Schedule Window, Schedule Pane, 
double click the time you wish to edit 
 
3) In the Schedule Window, Summary Pane, 
double click either the Start or End Date. 
 

 

5.1.1.5. Schedule Dependency 
You can define scheduling dependency such that if task1 is delayed, all other dependent task schedules are 
pushed back automatically. 
 

 
 
To insert a dependency between two tasks, first make sure the tasks have schedules assigned to them.  
Then select the first task and press the Insert Dependency Button. 
Move your mouse near the first task and you'll notice pink and red snap points appear.  Just click any one of 
them. 
Now move your mouse near the second task hich will be dependent on the first task.  Again you'll see the 
pink and red snap points.  Pick one and you'll notice a red line with arrow showing the dependency. 
The dependency only shows on your Schedule pane. 
 

 
Red line above shows task dependency. 
 



 

 

 
In the Schedule pane, dependency is shown by a dark blue line. 

5.1.2. Calendar Window 

If a selected topic has associatedschedule information, 
then those dates will be highlighted on the Calendar. 
 
You can change the schedule directly on the Calendar 
pane by clicking on the dates.  Clicking on a selected date 
will de-select that date. 
 
If a selected topic does not have any schedule 
information, then clicking the dates on the Calendar will 
add schedule information. 
 
You can also set start and end times for your schedule, as 
well as the Achievement rate 

 

 
 

5.1.3. Resources 
Resources are anything that is required to complete a task, and they also cost money.  Resources can be people, 
machinery, transportation, etc.  You can define and assign resources for each task item. 

5.1.3.1. Define Resources 
You must schedule a topic before you can work with Resources.  Once a topic has a schedule, you can define 
and assign resources. 



 

 

 
To define a resource, go to Schedule Tab, Resource Group, Define Resources. 

 
 
You can also simply Right-click the topic with a schedule, choose Resource / Define. 
 

 
 
That will Open the Define Resource dialog box. 
 



 

 

 
 

Click the "+" button to add a Resource.  In this instance, we've defined 3 people (Bob, Joe, Mary), 3 
Machines (Jack Hammer, Bulldozer, Beam Projector), and 2 Contractors.  You can also input their rate as 
cost per unit.  Notice some have units of Hrs and some have units of Days. 

 

5.1.3.2. Assign Resources 
Once Resources are defined, they can be assigned to each task with a schedule. 
Select a topic (with a schedule) that needs to have Resources assigned. 
Start the Assign Resources dialog box by clicking the Assign Resource button in the menu. 
You can also use the right-mouse button, and choose Resource / Assign menu. 
 

 
 
Assign Resource Dialog box will appear: 



 

 

 
 
In this example, for this particular task, we've assigned Bob for 5 Hours and a Bulldozer for 2 Days.  The 
Planned cost is calculated automatically. 
As the project progresses, the Actual times can be filled in by you.  The Actual Cost will also be calculated 
automatically. 
 
The assigned resources and the summary of the cost for each task also appear in the Schedule Window 
 

5.1.4. Achievement Rate 
 

 

As the project progresses, you can update the 
Achievement rate for each task.  This rate 
show up in the Schedule bars in the Schedule 
pane. 
 
To set the Achievement rate, enter the 
Details Window by double-clicking either the 
schedule bar, or the dates in the Summary 
Pan. 
 
The Achievement rate is set to 60% in this 
case.  This is now reflected in the Schedule 
Pane with a hatch design. 

 
 



 

 

 
 

5.1.5. Exporting your Map to Microsoft Project 
Please keep in mind that MindMapper is a mind mapping tool with some Project Management features.  We do 
not compete with other professional Project Management software in the market.  Therefore, if you feel some 
Project Management features you require are lacking in MindMapper, we recommend that you export your Mind 
Map to Microsoft Project.  Then you can continue to manage your project using a professional Project 
Management package.  Please see Section 5.3.3 for more details on exporting to MS Project. 

5.2. Presenting Your Work 
MindMapper provides built-in Presentation capabilities.  You could choose to export your map over to Microsoft 
PowerPoint and present with PowerPoint as well, but this is another option for you should you wish to maintain and 
present the graphical nature of your maps. 

5.2.1. Brief with Outline 
 

 
 
Brief with Outline presentation will open an Outline window on the left side.  The topic you click in the Outline 
window will be highlighted in the main window, and all other topics will dim.  If you click a topic that contains 
other sub-topics in the Outline window, then the whole sub tree will become highlighted. 
 
You can click from topic to topic and talk or present about the topic.  All attention will be focused on that one 
highlighted topic. 
 



 

 

 

5.2.2. Brief with Scenario 
Brief with Scenario is similar to Brief with Outline.  The difference is much more area of the map is highlighted in 
this mode. 
 

 
 
The Outline Window on the left is now replaced with a Scenario Window.  A scenario is defined as one logical unit 
of the mind map.  Typically it will encompass one sub-topic of your map. 
 



 

 

 

5.2.3. Play Slides 
 

Play slides will present your mind map in full screen mode using scenarios (scenario is one logical unit of mind 
map).  Each slide, or scenario will show one sub tree of your mind map, beginning with the title of your map.  You 
can go forward to next slide using right arrow, and go back to previous slide using left arrow.  You can also use the 
mouse left button to proceed to next slide.  Click ESC to end the presentation. 
 

5.2.3.1. Play Slides Options 
 

 
 



 

 

5.2.3.1.1. Range 
Select the range of slides to play in the presentation.  Default is All 

 

5.2.3.1.2. Delay 
“Manually” requires that you move the slides by using the arrow keys or mouse click. 
“Automatically after”setting allowautomatic slide presentation. 

 

5.2.3.1.3. Repeat 
Checking Repeat will cycle the presentation so it will run continuously. 

5.2.4. Exporting your Map to Microsoft PowerPoint 
Please keep in mind that MindMapper is a mind mapping program with limited presentation features.  If you 
require more presentation features, we recommend that you export your Mind Map to Microsoft PowerPoint for 
professional presentation capabilities.  Please see Section 5.3.2 for more details. 

5.3. Integration with Microsoft Office 

5.3.1. Microsoft Word 

5.3.1.1. Export your map to Word document 
You can start the Export process by clicking on the MM icon and selecting Export menu 
 



 

 

 
 
This will start the Export to Microsoft Word dialog box 
 

 
 
Click OK to use the default settings to convert to Microsoft Word document.  Clicking Options will provide 
more options to fine tune your export process. 



 

 

 

5.3.1.1.1. Template File 
Select the Word template file (*.dot) if you wish to use your own.  Otherwise, you can use our pre-
installed Word template. 

5.3.1.1.2. Destination File 
Choose the folder and filename of your output Word file. 

5.3.1.1.3. Launch Microsoft Word upon completion 
Start Microsoft Word after conversion is complete 

5.3.1.1.4. Export E-Mail 
Convert to Word, and then start your e-mail program, automatically attaching the converted Word 
document in the email. 

5.3.1.1.5. Items to Export 
Choose items from your mind map that you wish to include or exclude from the Word document. 

 

5.3.1.2. Import Word document into Mind Map 
 

Press Microsoft Word button in the Import group to start the import process. 
 
The Word document you are converting must be using Word Styles.  Best Word documents to import are 
documents in Outline form using styles such as Heading1, Heading2, Heading3, etc. 
 
To see a perfect example of a formatted Word document, simply export one of your complex mind maps 
and look at the converted Word document carefully. 

 



 

 

 
 
 

First dialog to appear is the familiar Open Dialog box.  Navigate to where the desired Word document 
resides, and then click Open. 

 
 
Next dialog is the Import Microsoft Word dialog box.  This is the critical step of the Import Process.  You 
must match the styles used in your Word document to each level of your mind map. 
 



 

 

 
 
The right column shows all the styles used in your Word document.  Click the text box next to Main Title, 
and then choose the style used for the title in your Word document in the right column.  When you find the 
corresponding style, double-click it, or just press the Arrow button in the middle of the dialog box. 
 
Now click the text box next to Heading 1 Topic, and then locate the styles in use for Heading 1 topic in the 
right column.  Most likely it will be Heading 1 or Level 1.  Double click it or press the Arrow in the middle of 
the dialog. 
 
You must repeat the above steps for all the styles you wish to import into MindMapper.  If you're sure your 
Word document only goes 3 Headings deep (i.e. Heading 3), then you can stop after assigning Heading 3 to 
Heading 3 Topic box. 
 
Once you've assigned all the styles, press the OK button to see your Word document morph into a mind 
map. 
 

5.3.2. Microsoft PowerPoint 

5.3.2.1. Export Mind Maps to PowerPoint Slides 
 

Starting the PowerPoint Export feature will bring up this dialog box 



 

 

 
 
Click OK to export to PowerPoint using the default options.  Click Options to set more PowerPoint exporting 
options. 

5.3.2.1.1. Destination File 
Choose the folder and the filename of the output PowerPoint file. 

5.3.2.1.2. Launch Microsoft PowerPoint upon completion 
Start Microsoft PowerPoint after conversion is complete 

5.3.2.1.3. Export E-Mail 
Convert to PowerPoint, and then start your e-mail program, automatically attaching the converted PPT 
document in the email. 

5.3.2.1.4. Template 
Select the PPT template file (*.pot) if you wish to use your own.  Otherwise, you can use our pre-
installed PPT template. 



 

 

5.3.2.1.5. Options 

 
 
In Options, you can choose to include or exclude certain items during the conversion. 

 

5.3.2.2. Import PowerPoint Slides to Mind Maps 
 

Click PowerPoint button in the Import group to start the PowerPoint import process.  As with importing a 
Word document, you'll see a familiar Open dialog box, where you can locate the PowerPoint document 
you're attempting to import. 
Your PowerPoint slides must be using the design styles feature in PowerPoint. 
 



 

 

 
 

 
 
Before you complete the import process, you can choose to View the PowerPoint file by pressing the View 
button. 

5.3.3. Microsoft Project 

5.3.3.1. Exporting Mind Maps to Project 
This is a sample mind map with scheduling information 



 

 

 
 

To convert to a Microsoft Project file, click Microsoft Project in the Export group: 



 

 

 
 
That will show the Microsoft Project Export Window. 
 
In step 1), choose your destination folder and filename for the output Project file 

 
 
In Step 2) choose which items to include or exclude from your Project file. 



 

 

 
 
In Step 3) Choose to launch Project after conversion.   By checking “Export E-mail”, you can start your e-mail 
program and attach the converted Project file automatically. 

 
 
This is the sample output in Microsoft Project 



 

 

 
 

5.3.3.2. Importing Project into Mind Map 
 

Microsoft Project ships with a sample template called Commercial Construction.  In this example, we'll 
import that project file into MindMapper.  This is a screenshot of the Commercial Construction template: 



 

 

 
 
Click Microsoft Project in Import group to get started. 

 
 
Locate the Project file you'd like to import: 



 

 

 
 
Click OK to confirm importing 

 
 
Here is the resulting Project file imported into MindMapper, including all the tasks in Map form plus the 
Scheduling information in Gantt chart: 
 



 

 

 
 

5.3.4. Microsoft Excel 

5.3.4.1. Export Mind Map into Microsoft Excel Spreadsheet 
MindMapper allows 3 different types of exporting styles into an Excel spreadsheet.  For this example, we'll 
take this simple map. 
 

 
 
To start the Excel Export process, press Excel in Export group of the menu bar. 



 

 

 
 



 

 

That will start the Excel Export Wizard                                          

 
 

Horizontal Topic Arrangement: 

 
 
Vertical Topic Arrangement: 



 

 

 
 
Text Tree 

 
 
Notes and Schedules: If you choose to include Notes and Schedules, this information will be exported as 
Comments in each Excel cell. 
 
Current version of MindMapper can only export to MS Excel.  MindMapper currently does not import MS 
Excel worksheet. 

5.3.5. Microsoft Outlook 

5.3.5.1. Export Mind Map tasks to Microsoft Outlook Tasks 
You can export your MindMapper topics with schedule information to Microsoft Outlook.  The exported 
topics will be entered into Microsoft Outlook tasks.  The due date for the Outlook tasks will be the end date 
of the schedule in MindMapper. 
 

5.3.5.2. Import Microsoft Outlook Tasks into MindMapper 
Tasks you already have in Microsoft Outlook can be imported as a MindMapper file via the Import process.  
Tasks will import as a mind map tree structure, and any corresponding scheduleinformation will be added 
as the end date of the schedule. 

5.3.6. Microsoft OneNote 

5.3.6.1. Export Mind Map to Microsoft OneNote 
You can export your graphical mind map into free-drawing canvas of Microsoft OneNote. 
To start the command, press the OneNote button in Export group: 



 

 

 
 
Here is a sample mind map converted to Microsoft OneNote document: 
 
MindMapper 

 
 



 

 

OneNote 

 
 

5.4. More Ways to Share your Mind Maps with Others 
Besides converting your Mind Maps to an Office document for sharing with others, MindMapper also provides more 
ways to share with your colleagues. 
 



 

 

                     

5.4.1. Send As Map Attachment 
Start your default Email program and automatically attaches your current working MindMapper file for sending.  
Your colleague would require either the MindMapper program or a MindMapper Viewer to see the file. 

5.4.2. Send As Image Attachment 
Start your default Email program and automatically attaches your current working MindMapper file as an Image 
attachment.  Your colleagues just need any picture viewer to see your mind map file. 

5.4.3. Send As Image Attachment (Selected Area) 
Start your default Email program and automatically attaches your selected image of the map as an image 
attachment.   

5.4.4. Send As Pack Attachment 
Start your default Email program and automatically archives your current map with all the hyperlinked files into a 
single Pack file.  The Pack file is attached to your email.  Please see section 4.8 for Pack and Delivery feature. 

5.4.5. Send As PDF Attachment 
Start you’re your default Email program and automatically sends map file as PDF attachment. 
 

5.5. Personal Knowledge Management System (PKMS) 
The PKMS features were designed to organize and manage your collection of mind maps.  Once you start creating many 
mind maps, you'll find a need to search through your old maps looking for some particular information.  These functions 
will help you do that and more to truly make your collection of maps your own personal knowledge management 
system. 



 

 

5.5.1. Extract Topics 

 
 

Extract Topics allows you to search 
through your collection of mind maps 
and Extract topics with certain 
keywords.  All the found topics will be 
collected and combined into a new map. 
 
Clicking Extract Topics will open this 
dialog box. 
 
Text: enter the text you wish to search 
for here. 
 
Detail Conditions: you can check any 
other detailed search criteria 
 
Apply To: enter files and/or folders 
where you wish to search for your mind 
map files by clicking Add. 
 
Options: more search options to narrow 
your requirements 
 
 

 

 

5.5.1.1. Extract Topic Sample 
This diagram shows a sample document.  Below diagrams show the results of certain extraction operations.  
This example shows Extraction feature being applied to the current map.  However, Extraction can also be 
applied to all your saved maps on your computer. 

 
[ Original Map ] 



 

 

 
 

[ Extracted by Legend ] 
All topics with a Legend icon are extracted 

 
 
[ Extracted by Resource ] 
All Topics with a Resource are extracted 



 

 

 
 
[ Extracted by Text ] 
All topics containing text "Park", "Jim" and "Charles" are extracted 

 
 
[ Extracted by Text Color & Background Color] 



 

 

All Topics with Text Color Red and Background Color Yellow are extracted 

 

5.5.2. Search Maps 

 
 
Search Map feature will dig through all your saved mind maps and look for conditions that you specific for your 
search criteria.  All matched results will  
 

This sample will search for the keyword 
"project plan" in mind map files contained in 
"E:\Patrick Documents" 
 
You can add other file or folders to search by 
clicking the Add button. 

 
 



 

 

 
 
The search results are listed in a new "Search Map".  Double-clicking each item will open that map. 
 
If you choose the option "Add Search Results to the Current Map", in the previous dialog box, each search list will 
be added as a topic to your current map, and will be automatically hyperlinked so you can easily click the topic to 
open the file. 

 

5.5.3. Search Internet 
MindMapper allows you to select a topic and search the internet to learn more about the topic. 
 
This sample shows the topic "Funding" is selected. 

 
 
Clicking Internet will open your web browser and search the selected topic.  Default search engine is Google, but 
you can change this in the Options page.  See Section 5.5.3.1 "Changing your Search Provider". 
 



 

 

 
 
Below example shows the sample search results. 

 
 

5.5.3.1. Changing your Search Provider 
 

The default search provider is Google.  If you wish to change the search provider, goto Options window in the 
MindMapper menu. 



 

 

 
 
 
Setting your own Search Provider 
1) Launch your favorite browser (Internet Explorer, Chrome, Firefox, etc.) and go to your favorite search site (i.e. 

google.com, yahoo.com, msn.com, etc.) 
2) Now do a search on the text “TEST”.  It must be all capital letters. 

Copy the contents of the address bar and paste it into the "Search Provider" box shown above. 

5.5.4. Create Folder Map 
This feature allows you to capture a graphical representation of your folder structure in your hard drive and 
display as a mind map.  Each file in the map is automatically hyperlinked to the actual file. 
You can elect to increase the text font size if the folder size gets larger, or if the number of files in the folder is 
large. 
If the selected folder structure is too complex and it takes too long to create the map, you can press ESC to cancel 
the operation. 
 



 

 

 
 

 
 

5.5.4.1. Create Folder Map Sample 
 

This diagram shows a sample folder structure in "E:\Temp" with 4 folders: Data, MM, MyMusic, and 
MyPictures. 



 

 

 
 
This is the resulting operation in MindMapper: 

 
 



 

 

5.5.5. Sort Topics 

 

Sorting adds must more power and 
functionality in MindMapper.  You can 
easily sort topics based on a number of 
conditions. 
 
The parent topic of the items you want 
sorted must be selected first.  If the root 
(main topic) is selected, then the entire 
map is sorted. 
 
You can sort by the pre-defined set of 
Text, Legend, Text Color, Fill Color, 
Schedule or Achievement.  If you prefer 
customized Sorting, click Customize: 

 

Using the Customize option, you can make 
even more powerful sorting conditions. 

 

5.5.5.1. Sort Example 
 

Let’s assume we have the following document.  We’ll show various sorting conditions and the resulting 
document. 

 
[ Original Document ] 

 
 



 

 

[ Sorted by Topic Text] 
Child topics are sorted alphabetically. 

 
[ Sorted by Legend ] 
Child topics are sorted by the order of the Legend icons.  The order of the Legend icons is determined by 
their placement in the Legend Toolbar. 

 
 

[ Sorted by Text Color ] 
Child topics are sorted by the color of the text.  White comes first, and Black is last in this order. 

 
 

[ Sorted by Fill Color ] 
Child topics are sorted by the background color.  In this case, Black comes first, and White comes last. 



 

 

 
 
[ Sorted by Schedule ] 
Child topics are sorted by the start date of their schedule. 

 
 
 

[ Sorted by Achievement Rate ] 
Child topics are sorted by the Achievement rate of the tasks. 

 
 

5.5.5.2. Sort Example 

6. Chapter 6 – MindMapper Collaboration Service 

6.1. Introduction 
Online collaboration allows multiple people in remote locations to share and contribute to the same file, reducing 
time, space, and expenses compared with traditional meeting held in a physical conference room. 



 

 

6.1.1. MindMapper Collaboration Service 
MindMapper user can hold remote online meetings with other MindMapper users. Each participant can 
access the meeting through the internet.  

6.1.1.1.  Easily create meetings anyplace  
                                                Do you still meet in a conference room?  With MindMapper collaboration, you can join a meeting as  
        long as you have an internet connection   

6.1.1.2.  Reduce meeting time with simultaneous, real-time inputs 
                                                Each participant can input his/her ideas simultaneously in real-time.   

6.1.1.3.  Instantly create a meeting report when the meeting ends 
                                                MindMapper Collaboration will create a one page report of meeting automaticallyas the meeting 
concludes.   

6.1.2. MindMapper Collaboration Benefits 
 

Benefits of MindMapper’s visual representation added to the benefit of remote multi-users adding real-time 
input allows more efficient meetings and project management without time and space constraints.   

 Multiple users can input ideas simultaneously  
 Meeting participants can join the meeting remotely   
 Share multiple files using hyperlinking in your meeting map  
 Create meetings anywhere and anytime  
 Visualize the entire project flow in one map  
 Synchronous/Asynchronous map update  

6.1.3. MindMapper Collaboration Features 

6.1.3.1.  Invite MindMapper or non-MindMapper users  
   Participants do not need licensed MindMapper to have join collaboration service.   However, participants 
with a licensed copy of MindMapper will get the full benefit of     MindMapper program. 

6.1.3.2.  Automatic Report Generation  
   After the meeting, with a click of a mouse, you can generate a meeting minutes.   

6.1.3.3.  Document sharing 
   Share any or all your files with the meeting participants   

6.1.3.4.  Voting 
   Use the Voting feature to quickly decide on an issue   

6.1.3.5.  Meeting time scheduler 
   Set a meeting timer to end the meeting on time.   

6.1.3.6.  Chat 
   Chat with all or certain participants   

6.1.4. MindMapper Collaboration Process 
 

6.1.4.1. Create New Meeting 
• Login 



 

 

• Add a file to share with other 
• Add participants 
• Start collaboration with other 

 

6.1.4.2. Join a Meeting 
                                               A. As an invited participant without an account 

• Check email for MindMapper Collaboration invitation 
• Click Join Collaboration 

 
                                               B. As an invited participant with an account 

• Check email for MindMapper Collaboration invitation 
• Click Join Collaboration 
• Invited meeting will be stored in the By others menu 
• If you want to join the meeting again, simply go to the By others and click Join 

                                                  
   C. As an organizer 

• Click on any of the files listed in the By me menu 
• Click Join Collaboration 

 

6.1.5. MindMapper Collaboration Requirements 
Meeting Organizer needs to have MindMapper 12 Arena or Academic license to host an online collaboration 
meeting.  
Meeting Participants with a MindMapper 12 Arena or Academic license will enjoy the best online 
collaboration meeting experience. Meeting Participants without a MindMapper 12 Arena or Academic license 
can also join the online collaboration meeting . Internet Explorer is required, and they’ll also be required to 
download and install a plug-in on their computers.   

  



 

 

6.2. Getting Ready 

6.2.1. Updating MindMapper 
MindMapper Collaboration Service requires MindMapper 12 Arena.  You can update to the latest 
MindMapper build by going to the Help menu then choosing Check for Updates. 

 
 
You can verify if your MindMapper 12 Arena can use the Collaboration Services by looking at your menu.  If 
your menu contains the Collaboration tab, then your product is ready. 

                        

6.2.2. Create an Account 
You must create an account before using the service.  Please click Register on top right of the Arena main 
page.  
Or you can go to our website www.mindmapper.com and click Login then click Register to create a new 
account. 

 
 
Note: If you have already created an account for our previous online storage Web Folder, then you do not 
need to create another account. 
 
                                                            

http://www.mindmapper.com/


 

 

6.3. Create a New Collaboration Session 
 
 

To create a 
new 
meeting, 
click the 
New 
command in 
the Session 
group. 

 
 

You’ll be 
prompted to 
login.   
 
 

 
 
 
 

After logging 
in, you will 
see Arena 
window 
appear. In 
order to 
start a new 
collaboration 
click on New. 

 



 

 

                         

New 
Collaboratio
n     window 
will appear 
with Title, 
Password 
(optional), 
First Level 
Editing 
Permission, 
Description, 
Participants. 
 
Fill out the 
information 
and click 
Send 
Invitation. 
 
 
 
 
 
 

 
 
 

 

6.4. Collaboration Meeting Email 
 
When the meeting information is filled out, Send Invitation has been clicked, the collaboration emails will be sent to 
all participants.  The invitation email will contain information such as: 
 Collaboration File Name 
 Organizer 



 

 

 Date  
 Meeting Description 

 
The Meeting email will also contain a link to join the meeting.  The participants need to simply click this button to join 
a meeting. 
 

6.5. Arena Site Menu Explained 

6.5.1. Collaboration Menu 
 

 
A. New: Browse your local 
computer             and upload 
TWDX file you want to        
share with others. 
 
B. Recent: List of most 
recent files you have 
worked on. 
 
C. By me: List of files you 
have shared.  You are the 
organizer of the meeting. 
 
D. By others: List of files 
others have shared with 
you.  You are the 
participant of the meeting.  
 
E. Address book: List of 
contacts by individuals or 
groups. 
 
F. Image view: Click this 
button to see the preview 
of the file. 
 
G. Post: You can post your 
map to social media outlets 
or message boards.  Simply 
past the HTML source code 
and input it to any outlets 
that allows direct HTML 
input.  If not, you can still 
copy the map link and paste 
it to social media outlets or 
message boards.  Anyone 
who clicks on the link will 
be able to see the map in 
Flash viewer. 
 

 
 
 

 



 

 

I. You can view your maps 
in thumbnail or list. 
 
 

6.6. Join a Meeting 

6.6.1. For Account Holders 
 

 
Start 
MindMapp
er and click 
Join in the 
Session 
group 

 
 

 
You’ll be 
prompted 
to login. 

 
 
 



 

 

 
 
 
 
 
Select a file 
from 
Recent 
menu, or  
from files 
shared by 
you (By me 
menu), or 
from files 
shared by 
others (By 
others 
menu) and 
click Join.  
 
 
 
 
 

 

 

6.6.2. For Participants 
 

6.6.2.1. MindMapper 12 Arena/Academic Users 
 

Be sure to update your MindMapper to properly use the Meeting features.   
 
To join a meeting, simply press the Join Collaboration button in your collaboration invitation email.  
This will automatically start your MindMapper program and join the meeting. 
 
However, if your email invitation has been lost, you can still join collaboration using MindMapper 
program.  However, this can be done if you are a registered member of MindMapper Arena and the 
organizer added your ID to the list of invited participants for the collaboration meeting.  
 

6.6.2.2. Non-MindMapper Users 
 

For users who do not own a license of MindMapper 12 Arena, we offer iMindMapper that is equal 
in look and feel, as well as feature-set, as the MindMapper 12 Arena program. 
 
iMindMapper requires Internet Explorer, and you need administrative privilege to download and 
install a plug-in on your computer. 
 



 

 

To join a meeting, be sure your Internet Explorer is set as the default browser, then click the Join 
Collaboration button in your collaboration invitation email. 
 
You’ll get a warning to install the iMindMapper software.  Click Install 
 

                                                          
 

After installing, you’ll be joined in the meeting automatically via iMindMapper. 
 

6.7. Running a Meeting 
 
Running a MindMapper Collaboration Service meeting is a breeze for MindMapper users, since the same program is 
used for the meeting.  You can do all of your MindMapper tasks, such as assign a topic, adding sub-topics, moving 
topics, adding styles, adding schedule, etc. 
For information on using MindMapper, please refer to chapters 2 through 5 in this help manual. 
 

6.7.1. MindMapper Collaboration Window 
This is an overview of the MindMapper Collaboration window: 
Left pane contains the Attendee list, and a Chat window.  
The Menu bar adds Collaboration tab with pertinent menu groups, such as Session, Vote, and Report. 
 



 

 

 
 

 
 

6.7.2. Attendee List 
 

Attendee List shows all the logged in attendees and also their status. 
If you click on an attendee, the map will show the branches that they have added, showing their input and 
participation. 

                                        
 
In the above example, blue icon shows that participant is online.  (M) denotes moderator.  Greyed out icons 
represent participants who are not online. 

6.7.3. Chat  
 

To send a chat to everyone, just type in your text into the Chat box and press Send.  Everyone in the meeting 
will see your message. 
 
 



 

 

Private Chat 
 
To chat privately with an individual, select that 
attendee, and click the Chat button.  A separate chat 
window will open. 
 
Note: Private Chat works only when 3 or more people 
are logged into the meeting. 

 
 

 
 
 

6.7.4. Add Attendee 
 

If you would like to add more attendees for the shared map collaboration, click on Add Attendee to send an 
invitation to join. 
 

6.7.5. Request Reply 
You can use Request Reply to ask for input from certain attendee on a specific topic. 
 
Steps to use Request Reply: 

• Select a topic where you want another attendee to answer 
• Next, select the attendee who should provide an answer 
• Click Request Reply button 

 
The selected topic will now show that you’re expecting a reply on the subject.  The attendee in the meeting 
should see the message and add his/her thoughts to the topic. 



 

 

6.7.6. Change Moderator 
                               You can change the moderator of the collaboration session.  By default, the one who shared the file 
automatically becomes the moderator. 

6.8. Vote 
 

Voting allows you to quickly make a decision in real-time with everyone’s input.  You can use the Vote feature 
to decide which of the selected candidates are the best choice. 
 
In the below example, suppose you’re split between the schedule being on Monday or Tuesday.  To put that 
to a vote: 
 
 
Select the candidates (in this case, 
Monday and Tuesday) and click 
Define as Choices in the menu. 
 
Vote dialog box will pop up. 
Enter the Subject for this vote and 
click OK    
 

 

 
 
Select the duration of the Voting 
period and then click Start. 
 
Every attendee will see this dialog pop 
up on their screen. 
 
Select your Preference and click Vote. 
 
When all votes are in, you’ll see real-
time results on the screen. 
                                                                             

 

6.9. Minutes 
 

Minutes menu has 3 functions: Preview, Save, and Tool 



 

 

                                                                                                                                                        

6.9.1. Preview 
Preview command transfers your current mind map into a Word report format and lets you edit the 
content before saving as a Word document. 

6.9.2. Save 
If you’re satisfied with your meeting report and do not need any editing, then you can use this 
command to save your mind map to a Word document. 

6.9.3. Tool 
Share command lets you share your mind map with others by other means, such as saving to MS 
PPT format, sending as email, or saving as PDF, for example.  

 
 

6.10. Control 
                   Control menu has 6 functions: Create Meeting Link, Attendee Statistics, Split Meeting, Topic Permission, Save 
Limit, Version History. 



 

 

                                                          
 

6.10.1. Create Meeting Link 
 

  This creates a link to the meeting that you can paste onto any communication medium such as email, SMS, 
messenger, Facebook and so on.  Just click on the link and iMindMapper       will load to begin collaboration 
session. 

6.10.2. Attendee Statistics 
 
                                 This feature provides number of topics each participant created. 

6.10.3. Split Meeting 
 
                                  If you have a topic that needs to be worked on separately, you can split that topic branch and make it into 
another shared map.  This newly split map is not hyperlinked to the original                    collaboration map. 

6.10.4. Topic Permission 
 
                                 You can assign read/write permission to topic and its children.  

6.10.5. Save Limit 
 
                                  With Save Limit, you can limit certain attendees from saving work in the map. 

6.10.6. Version 
 

              Version and Revision manager allows you to keep track of the meeting map’s changes.  You can create a 
snapshot version of a particular map, and then go back to that snapshot if       you feel the meeting map is not 
progressing in the direction you are thinking. 

 
Versions are not created in real time.  You must save the current map, then end your session (for yourself only), then 
re-join the meeting to see the revision history. 
 



 

 

 
 

6.10.6.1. Version and Revision Manager 

6.10.6.1.1. View 
    Click view to the view the current actions entered into the map.  The list is comprehensive from   
 all user inputs. 

6.10.6.1.2. Create Version 
 To create a snapshot of the current map, choose Create Version and enter a descriptive name. 

6.10.6.1.3. Rollback 
 Choose Rollback to go back to a previous Created Version.  Map will automatically regress back to   
 the saved point, and you can continue your meeting from that    point forward. 

6.10.6.2. Revision Detail 

6.10.6.2.1. View 
    View details of the current version 

6.10.6.2.2. Play 
    Play the current version from the beginning, showing the task and steps of each input. 

 

6.11. Ending a Meeting 
 
                 To end the meeting, click on End menu from the session group. 

                  
 
                   You have 2 different options to end a meeting. 
 



 

 

                
 

                 Be sure to check “Save meeting map on my PC” if you want to save your meeting map locally on your 
computer. 
 

6.11.1. End the meeting now for everyone 
                                This finalizes the current meeting, and everyone will be prompted to leave the meeting.  Everyone will have a  
chance to save the meeting map file locally on their computer. 

 

6.11.2. Keep meeting open for others but quit my session 
The Meeting organizer can quit his/her session, but still keep the meeting open for the other attendees. The 
remaining attendees can contribute to the meeting map, and can also exit and join the session freely while the 
meeting is open to others. 

 
                                The Meeting Organizer can re-join the meeting anytime to check the progress of the meeting map.  To join the 
meeting, follow the steps outlined in section 6.5.1 

 
                                Attendees can also leave and re-join the meeting.  For attendees, please use the email link to re-join the 
meeting.  This is outlined in section 6.5.2. 

 

6.12. Collaboration Service Options 
       Collaboration Options are available in the MindMapper Options dialog box. 
 



 

 

        
 
Setting: Option to save collaboration session locally 
Minute: Controls Meeting Report Minutes options 
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